User’s Guide

The ESA/ESO/NASA Photoshop FITS Liberator

v.2.3
Colophon
This User’s Guide was written by Robert Hurt, Lars Lindberg Christensen, Kaspar K. Nielsen and Teis Johansen

The team behind the ESA/ESO/NASA Photoshop FITS Liberator:

Project Lead: Lars Lindberg Christensen (lars@eso.org)
Development Lead: Lars Holm Nielsen
Core Functionality: Kaspar K. Nielsen
Engine and GUI: Teis Johansen
Scientific, technical support: Robert Hurt
Testing: Robert Hurt, Davide de Martin

Acknowledgements

FITS is an abbreviation for Flexible Image Transport System. FITS has been a standard since 1982 and is recognised by the International Astronomical Union.


Adobe® and Photoshop® are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

We kindly ask users to acknowledge the use of this plug-in in publicly accessible products (web, articles, books etc.) with the following statement: This image was created with the help of the ESA/ESO/NASA Photoshop FITS Liberator.

Cover:
This is a 34 by 20-degree wide image of the area near the galactic centre. The image shows the region spanning the sky from the constellation of Sagittarius (the Archer) to Scorpius (the Scorpion). The very colourful Rho Ophiuchi and Antares region features prominently to the right, as well as much darker areas, such as the Pipe and Snake Nebulae. The image was obtained by observing with a 10-cm Takahashi FSQ106ED f/3.6 telescope and a SBIG STL CCD camera, using a NUP160 mount. Images were collected through three different filters (B, V and R), “liberated” with the FITS Liberator and then stitched together. This mosaic was assembled from 52 different sky fields made from about 1200 individual images totalling 200 hours exposure time, with the final image having a size of 24 403 x 13 973 pixels.
Credit: ESO/S. Guisard
This image was created with the help of the ESA/ESO/NASA Photoshop FITS Liberator.
# Table of Contents

1. Introduction to the FITS Liberator ................................................................. 4
2. Installing the FITS Liberator ........................................................................... 7
   2.1 FITS Liberator v.2.3 System Requirements .................................................. 8
   2.2 Windows Installation ..................................................................................... 8
      2.2.1 Installing with the Setup Program ........................................................... 8
      2.2.2 Manual installation under Windows ........................................................ 8
   2.3 Mac OS X Installation ................................................................................... 9
      2.3.1 Manual installation under Mac OS X ....................................................... 9
   2.4 Uninstall information ................................................................................... 10
3. FITS Liberator Basics ..................................................................................... 11
   3.1 The FITS Liberator Interface ....................................................................... 12
   3.2 The FITS Liberator Workflow ..................................................................... 13
   3.3 Handling High Dynamic Range Images ........................................................ 13
      3.3.1 A Quick Example of Stretch Functions ................................................... 14
      3.3.2 More about Stretch Functions ................................................................ 14
      3.3.3 Scaling Images for Better Stretches ......................................................... 15
   3.4 Entering Metadata ....................................................................................... 16
   3.5 Other Utilities ............................................................................................... 18
      3.5.1 FITS Concatenator Script ...................................................................... 18
      3.5.2 Colour_composite Action ...................................................................... 18
      3.5.3 Metadata Panels ...................................................................................... 18
4. Cookbook Examples ........................................................................................ 21
   4.1 Step-by-step Image Import ......................................................................... 22
   4.2 Making a Colour Composite Image .............................................................. 22
5. Reference Guide ............................................................................................... 24
   5.1 Tabs ............................................................................................................... 24
   5.2 Processing Tab: Tools .................................................................................. 27
   5.3 Processing Tab: Preview Window ................................................................. 28
   5.4 Processing Tab: Histogram Window .............................................................. 29
   5.5 Processing Tab: Image Data ......................................................................... 28
   5.6 Processing Tab: Image Statistics .................................................................. 27
   5.7 Processing Tab: Scaling and Stretch (Advanced) .......................................... 29
   5.8 Processing Tab: Channels ............................................................................ 31
   5.9 Processing Tab: Undefined Values ............................................................... 32
   5.10 Processing Tab: Other Settings .................................................................... 32
   5.11 Preferences Dialog ....................................................................................... 33
A. More about Metadata ....................................................................................... 35
B. Behind the scenes ............................................................................................ 38
1 Introduction to the FITS Liberator

The Wide Field Camera 3 (WFC3), a new camera aboard the NASA/ESA Hubble Space Telescope, snapped this image of the planetary nebula, catalogued as NGC 6302, but more popularly called the Bug Nebula or the Butterfly Nebula.
Credit: NASA, ESA and the Hubble SM4 ERO Team
The release of version 2 of the popular ESA/ESO/NASA Photoshop FITS Liberator image processing software has meant that it is even easier and faster to create colour images using raw observations from a range of telescopes, including the NASA/ESA Hubble Space Telescope, NASA’s Spitzer Space Telescope, ESO’s Very Large Telescope and ESA’s XMM-Newton Telescope.

Version 1 of the ESA/ESO/NASA Photoshop FITS Liberator was completed in July 2004 by imaging scientists at the European Space Agency, the European Southern Observatory and NASA. FITS stands for Flexible Image Transport System. This single file format archives nearly all images of stars, nebulae and galaxies produced by major telescopes around the world. Before July 2004 this file format was primarily accessible to scientists working with highly specialised image processing tools.

More than 60,000 laypeople, educators and amateur astronomers have started using the Liberator since the release of v.1 in July 2004. The FITS Liberator has also become the industry standard for professional imaging scientists at the European Space Agency, the European Southern Observatory and NASA.

Stunning images such as the iconic Hubble image Pillars of Creation (Figure 1) can be created in a matter of minutes using version 2 of the FITS Liberator. Versions 2.0, 2.1 and 2.2 had several notable improvements over v.1.0:

- FITS images with up to 4 billion greyscale levels can be processed (32-bit support).
- FITS images with up to 500 million pixels or more can be processed (100 times larger than standard images from a digital camera).
- An improved user interface and a re-designed order of operations simplify the overall process – for example, the plug-in now remembers previous settings.
- New options for advanced Scaling and Stretching to fine tune images for optimal results.
- A whole section dedicated to inputting metadata, i.e. information about the image and what it shows. Metadata will be an important tool for future efforts to make archives of ‘pretty pictures’ more accessible.
- User access to a text version of the original FITS header. Universal Binary for Mac allows native CS3 operation on Intel-based systems.
- Flip image checkbox allows image orientation to be selected on import.
- Root functions ($x^{1/2}$, $x^{1/3}$, $x^{1/4}$, $x^{1/5}$) now operate antisymmetrically about $x=0$.
- Version 1.1 of the Astronomy Visualization Metadata (AVM) standard is now fully supported. For more information see http://www.virtualastronomy.org
- The import of coordinate metadata from the FITS header has been improved.

**Version 2.3 of the FITS Liberator include the following new features:**

- Full support for Photoshop CS4 (on both Mac and Windows).
- Significant performance (speed) enhancement through the usage of multiple CPUs and CPU cores as well as an improved memory management strategy (helpful especially for large images).
- Support for planetary images through the PDS image format.
- Metadata editing support for Photoshop CS4.
- Options has been added including the histogram markers stretched mean, stretched median, peak level and background level.
- It is now possible to change the default initial guess between three different modes (a specified percentage of the histogram for the black and white levels, the mean +/- the standard deviation or the median +/- the standard deviation).
- The World Coordinate System (WCS) coordinates are now given when the user sweeps the image pixels with the mouse pointer.
**Figure 1** Version 2 of the FITS Liberator makes it even easier to create stunning images. The iconic Hubble image Pillars of Creation, seen here, can be created in a matter of minutes. The three-colour dataset used to create this image can be downloaded from: [http://www.spacetelescope.org/projects/fits_liberator/eagledata.html](http://www.spacetelescope.org/projects/fits_liberator/eagledata.html).

The advantages of using FITS Liberator over professional image processing tools are indicated in the right-hand image:

1. Added detail in the shadows.
2. Increased gamut (colour space, more nuances).
3. Slightly better noise characteristics.
4. Easier access to advanced cosmetic cleaning tools as demonstrated by the removal of ghosts.
2 Installing the \textit{FITS Liberator}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{image.png}
\caption{Image of part of a stellar remnant whose explosion was recorded in 185 AD. By studying this remnant in detail, a team of astronomers was able to solve the mystery of the Milky Way’s super-efficient particle accelerators. The team shows that the shock wave visible in this area is very efficient at accelerating particles and the energy used in this process matches the number of cosmic rays observed on Earth. North is toward the top right and east to the top left. The image is about 6 arc minutes across.}
\label{fig:stellar_remnant}
\end{figure}

Credit: ESO/E. Helder & NASA/Chandra
2.1 FITS Liberator v.2.3 System Requirements

Minimum requirements:
- Windows PC (XP, Vista or Windows 7) or Mac (OS X 10.4+);
- Screen resolution of 1024 x 768 pixels or better;
- Photoshop 7.0 (or later) or Photoshop Elements 2.0 (or later);
- Mac: Photoshop CS 3 or CS 4.

Limitations by Photoshop version, Photoshop Elements and CS, known issues:
- Photoshop CS2, CS3 (32-bit colour depth);
- Photoshop CS (16-bit);
- Photoshop Elements 3 to Elements 6 (16-bit);
- Photoshop 7.0 (only 15-bit colour, and only partial functionality for more than 8-bit colour);
- Photoshop Elements 2 (only 8-bit colour) (Elements 1.0 NOT supported);
- Mac: Only Photoshop CS3 and CS4 are supported.

Other limitations:
- As the loading process is very I/O intensive, the performance may be decreased significantly when loading FITS files from a network drive. In this case the plug-in will show a notification. It is recommended, if possible, to copy files to the local hard disk drive before opening them with the FITS Liberator.

2.2 Windows Installation

The FITS Liberator can be installed on Windows either by using a setup program or manually. In both cases, a local administrator must install the plug-in. By default, all users on Windows XP machines are local administrators.

2.2.1 Installing with the Setup Program

The recommended way of installing the FITS Liberator on Windows is to use the setup program. This will install all the necessary files and optionally register FITS files with Photoshop.

2.2.2 Manual installation under Windows

To install manually, download the manual installation package and extract the files to a directory. Next, move the files into the correct locations in the file system. Note that if you are using a version other than CS3 or a localised version of Photoshop the folder names will differ.

<table>
<thead>
<tr>
<th>File</th>
<th>Location and example</th>
</tr>
</thead>
<tbody>
<tr>
<td>FitsLiberator.8bi</td>
<td>(Program Files)\Photoshop\Plug-Ins\File Formats</td>
</tr>
<tr>
<td></td>
<td>e.g.: C:\Program Files\Adobe\Adobe Photoshop CS3\Plug-Ins\File Formats</td>
</tr>
<tr>
<td></td>
<td>and</td>
</tr>
<tr>
<td></td>
<td>(Program Files)\Bridge\Plug-Ins</td>
</tr>
<tr>
<td></td>
<td>e.g.: C:\Program Files\Adobe\Adobe Bridge CS3\Plug-Ins</td>
</tr>
<tr>
<td>FITS Concatenator.jsx,</td>
<td>(Program Files)\Photoshop\Presets\Scripts</td>
</tr>
<tr>
<td>xmlsax.inc,</td>
<td>e.g.: C:\Program Files\Adobe\Adobe Photoshop CS3\Presets\Scripts</td>
</tr>
<tr>
<td>xmlw3cdom.inc</td>
<td></td>
</tr>
<tr>
<td>ColourComposite.atn</td>
<td>(Program Files)\Photoshop\Presets\Photoshop Actions</td>
</tr>
<tr>
<td></td>
<td>e.g.: C:\Program Files\Adobe\Adobe Photoshop CS3\Presets\Photoshop Actions</td>
</tr>
<tr>
<td>UserGuide.pdf</td>
<td>(Program Files)\Photoshop FITS Liberator</td>
</tr>
</tbody>
</table>
Important: You should create a file named AstronomyVisualization.cfg in {System}\Macromedia\Flash\FlashPlayerTrust. For 32-bit Windows {System} is usually C:\Windows\System32 whereas for 64-bit Windows {System} is usually C:\Windows\SysWOW64. The file must contain the path to location of the CS4 XMP panels (e.g.: C:\Program Files\Common Files\Adobe\XMP\Custom File Info Panels\2.0\panels\AstronomyVisualization).

If there is an additional plug-ins folder, the FitsLiberator.8bi file can be placed in that folder instead.

2.3 Mac OS X Installation

Installing FITS Liberator on a Mac consists of just a few steps:

1. Open the disk image.
2. Double-click on the FITS Liberator installer (FITS Liberator.mpkg) and follow the steps in the installer. Note: Make sure you select the correct destination.
3. Double-click the Extras.mpkg file to install the File Info… panels and FITS Concatenator script. You may have to select your preferred Photoshop installation folder depending on the version you are running.
4. Eject and discard the disk image.

2.3.1 Manual installation under Mac OS X

<table>
<thead>
<tr>
<th>File</th>
<th>Location and example</th>
</tr>
</thead>
<tbody>
<tr>
<td>libtbb.dylib</td>
<td>/usr/lib</td>
</tr>
<tr>
<td>libtbbmalloc.dylib</td>
<td>/usr/lib</td>
</tr>
<tr>
<td>FITS Liberator.plugin</td>
<td>/Applications/(Photoshop)/Plug-Ins/File Formats</td>
</tr>
<tr>
<td></td>
<td>e.g.: /Applications/Adobe Photoshop CS4/Plug-Ins/File Formats</td>
</tr>
<tr>
<td>FITS Concatenator.jsx, xmlsax.inc, xmlw3cdom.inc</td>
<td>/Applications/(Photoshop)/Presets/Scripts</td>
</tr>
<tr>
<td></td>
<td>e.g.: /Applications/Adobe/Adobe Photoshop CS4/Presets/Scripts</td>
</tr>
<tr>
<td>ColourComposite.atn</td>
<td>/Applications/(Photoshop)/Presets/Photoshop Actions</td>
</tr>
<tr>
<td></td>
<td>e.g.: /Applications/Adobe/Adobe Photoshop CS4/Presets/Photoshop Actions</td>
</tr>
</tbody>
</table>
2.4 **Uninstall information**

On Windows go to Control Panels -> Add or Remove Programs -> Remove Photoshop FITS Liberator 2.3. A manual de-installation can be done by removing the files in the list under 2.2.2 above.

On Mac remove the files in the manual installation list above.
3 FITS Liberator Basics

Figure 3 This image is a blend of the Galaxy Evolution Explorer’s M33 image and another taken by NASA’s Spitzer Space Telescope. M33, one of our closest galactic neighbors, is about 2.9 million light-years away in the constellation Triangulum, part of what’s known as our Local Group of galaxies. Credit: NASA/JPL-Caltech
3.1 The FITS Liberator Interface

The FITS Liberator acts as an import filter for Photoshop, presenting the user with an interactive interface for adjusting the import settings. It can be thought of as a “Camera RAW” plug-in for astronomical data as the general philosophy is the same: raw data from digital detectors, in cameras or telescopes, need some special processing before they can be used in Photoshop.

The FITS Liberator has four sections accessed by the four tabs along the top of its window. The Processing tab contains all of the image import settings. The Metadata tab allows users to enter descriptive information that will be embedded into the image. The FITS Header tab allows users to view the contents of the header of the image. The Help Guide provides a short introduction and usage instructions.

![The Liberator's Graphical User Interface. A more detailed overview can be seen in Figure 11. Credit: ESA, ESO & NASA.](image)

The Processing tab in the Liberator interface (Figure 4) holds all the settings the user needs to adjust for image import. The interface is laid out in seven main areas:

**Preview Window (1):** This shows what the image will look like given the current import settings. It is possible to zoom and pan to focus on specific areas of interest in a large image.

**Histogram Window (2):** This shows the displayed brightness distribution of pixels in the image. This can be helpful in identifying Background and Peak levels. The histogram updates as the user changes the Stretch functions. Black and White levels can be set by sliders under the window or from the text entry boxes below. It is possible to zoom and pan the histogram to expand areas of interest or to more precisely set black and white levels.
Tools (3): These tools allow the user to manipulate the Preview and Histogram windows interactively. The eyedropper tools set levels by sampling the image.

Image Statistics (4): Various numerical statistics about the whole image are displayed in these boxes. The upper area gives the values underneath the cursor in the preview window.

Scaling and Stretch (5): These settings allow the user to adjust the image by applying a variety of mathematical functions to the FITS data before it is displayed. This is necessary to bring out faint details in images with a high dynamic range.

Image Import Settings (6): Here the user selects the desired format of the imported image. This includes the bit-depth (number of bits of greyscale information in each pixel) and transparency settings for pixels tagged as “blank” in the FITS data.

Preference Settings (7): The user may set these toggles to customise various aspects of the interface including clipping warnings and numeric display settings. It is also possible to adjust whether an image is flipped for the import and if the import settings should be “frozen” for subsequent images.

NOTE: The FITS Liberator has a number of editable text fields in the main panel and preference windows. Note that for new values to be accepted into the field the user must either hit the TAB or ENTER keys (in the preferences window, use TAB; ENTER will accept changes and close the window). Entering a number into a field and simply clicking “OK” will not retain the new value.

3.2 The FITS Liberator Workflow
The basic sequence of steps for importing an image is (numbers refer to Fig. 4):

1. Examine the image as rendered in the Preview window (1).
2. Adjust the Black and White level sliders (under the Histogram (2)) to show the full range of the image.
3. If the image is too dark, click Auto Scaling and apply a Stretch function (5) to expand the dynamic range. Note that increasing the Scaled peak Level afterwards will increase the Stretch level (for Stretch functions such as ArcSinh and Log)
4. If desired, go to the Metadata tab and enter contextual information about the image.
5. Click OK to import when satisfied with the image preview and metadata entry.

A complete overview of all the Liberator controls can be found in Chapter 5.

3.3 Handling High Dynamic Range Images
Often astronomical images have a very high dynamic range, or many greyscale levels. This means that the brightest areas of interest — for instance the core of a galaxy — may be many thousands (or even millions) of times brighter than the faintest structures in the image — for instance a faint nebula at the edge of the image.

However, on a computer screen, one only can see 256 levels of brightness (8-bit greyscale). If the original high dynamic range image is imported directly into Photoshop using simple linear scaling, either the detail in the fainter structures is lost in the black background, or the brightest objects over-saturate (or burn in).
Photoshop can partially compensate for this by applying Levels or Curves transformations after the FITS image has been imported. However, an image that has been reduced to 8 bits can only be adjusted a little bit before it begins to “posterize”, showing discrete steps in brightness that obscure low-level features. Even extreme Curve adjustments cannot bring out the faintest detail in some of these images. The answer is to apply Scaling and Stretch (5) before importing, as described below.

![Figure 5](image.png) Astronomical images contain many more greyscale levels than can be viewed on a computer monitor or printed. In the image to the left a “normal” or linear representation of the image is shown. To the right the effect of a non-linear Stretch, a Logarithmic Stretch, is shown. By using a non-linear Stretch it is possible to enhance some greyscale levels in the image more than others and so to make faint details visible without saturating the brighter parts of the image.

### 3.3.1 A Quick Example of Stretch Functions

While there are a lot of potentially confusing elements in the Scaling and Stretch (5) section, the process can actually be quite quick and easy. To begin, select a FITS file that has a lot of dynamic range (galaxies are often good for this) and open it in the FITS Liberator. Now try the following:

- Use the sliders in the Histogram (2) to adjust the levels to show the full range of the image. Enabling the White and Black clipping checkboxes on the right (7) can help to make sure that nothing of interest is lost.
- Click the Auto Scaling button (5). The histogram settings have now been copied over to the Background and Peak levels. The Scaled peak level has been set to a default of 10.
- Choose $x^{(1/2)}$ from the Stretch functions pop-up. Notice how much brighter the faint features have become.
- Try out the other Root functions: $x^{(1/3)}$, $x^{(1/4)}$, $x^{(1/5)}$. Notice how each successive one brings the faint features up even more — probably too much!
- Now choose ArcSinh(x) from the Stretch functions pop-up. The image will get a bit darker.
- Increase the Scaled peak level to 100, then 1000, and finally 10,000. Notice that again the faint details are brought up more at each step.

These basic steps cover most of the practical information one needs to know about using Stretch functions and adjusting them to the needs of a specific image. The details, however, must be covered as well.

### 3.3.2 More about Stretch Functions

The FITS Liberator can easily handle high dynamic range images by allowing the user to apply a Stretch function to the data before it is rendered as an image. The settings in the Scaling and Stretch section (5) offer all the flexibility needed to render all the details in any image quickly.
The user has a choice of a variety of mathematical functions in the Stretch function pop-up menu. The inverse hyperbolic sine (ArcSinh) and Root Functions (\(x^{1/2}\) [square root], \(x^{1/3}\), \(x^{1/4}\), etc.) are the most commonly used, but others including the logarithm (Log) and compound functions are available as well. The chosen function will be applied to the FITS data before it is converted to greyscale. In some ways this mimics the perceptual ability of the human eye, which can accommodate to perceive dramatically different levels of brightness simultaneously.

Note that ArcSinh is generally preferred over Log. The two have very similar effects on the image, but ArcSinh is well behaved and symmetric around zero. Log, however, “blows up” at zero and can be harder to use effectively.

Each Stretch function affects the rendering of a high dynamic range differently. The user may find that different functions are preferred for different images. Since the effects are difficult to predict, it is best to experiment with different functions on several images and to observe the results.

The Linear Stretch function applies no transformation at all to the dynamic range of the image.

### 3.3.3 Scaling Images for Better Stretches

The Stretch functions work best when an image is properly scaled. All of them benefit when the “black” part of the image is numerically equal to zero, and some functions produce different effects if the overall scaling of the image is changed. The three numeric settings in the Scaling and Stretch (5) section allow the user to modify the values of the source FITS data as needed.

- **Background level**: numeric value of the noise level in the original image. This number will be subtracted from the data before the stretch function is applied.
- **Peak level**: numeric value of the brightest sources of interest.
- **Scaled peak level**: target value for the brightest sources before applying the Stretch function. This affects the dynamic range of the ArcSinh and Log functions.

Setting the background level is critical for all of the Stretch functions. While some FITS images may already have been processed so their Background levels equal zero, others commonly have offsets. If not removed, these offsets can make it impossible to recover faint details. The **FITS Liberator** will subtract the value of the Background level from the data before applying the Stretch function.

For Root functions, the Background level is the only setting that affects the results. ArcSinh and the related Log function, however, depend on the overall scaling of the data as well. These two families of Stretch functions, Root and ArcSinh, compress the dynamic range in different ways. To increase the dynamic range compression for the two cases:

- **Roots**: Choose higher order Root Stretch functions from the pop-up menu.
- **ArcSinh/Log**: Increase the value of Scaled peak level.

To set the image scaling for the ArcSinh function, the Peak level should be set to the numeric value of the brightest areas of interest in the image. The Scaled peak level can be adjusted to different values to fine tune the overall appearance. In general, use larger Scaled peak values to bring out fainter details.
To scale an image quickly, set the Black and White level sliders in the Histogram (2) to the desired levels and click Auto Scaling in the Scaling and Stretch (5) section to copy those settings over to the Background and Peak levels. The Scaled peak level defaults to 10, which has a very mild stretch effect, but the default value can be changed in the user preferences. Increasing this number to higher values (100, 1000, etc.) will yield stronger effects. The image below (Figure 6) demonstrates the effect of different Stretch functions and different values of the Scaled peak level.

**Figure 6** The range of available FITS Liberator Stretch functions are shown here. The top two rows show all the Stretch functions, in approximate order of their effect. Image Scaling is constant for all of these, with the White level of the galaxy nucleus set to 10. The bottom row shows the effect of changing the Peak Scaling while using Log(x), (functionally equivalent to ArcSinh(x) in this example). Note that this single function allows a faint structure to be enhanced smoothly. The Root functions are not affected by Scaling, but the compound functions, which use Log or ArcSinh terms, do depend on it.

### 3.4 Entering Metadata

Metadata can be defined as information about the data. Metadata allows an image to be identified, catalogued and used in flexible ways by giving the user access to a database of information about the file. Version 2 of the *FITS Liberator* allows a user to tag images with a full set of metadata that are saved within the image file itself. Image metadata includes information about what is in the image and where it can be found. The metadata can be read by anyone who later opens the image in Photoshop or another metadata-aware program.

The *FITS Liberator* v.2.3 supports version 1.1 of the Astronomy Visualization Metadata (AVM) standard. This standard is being developed by the Virtual Astronomy Multimedia Project (VAMP), an international standards collaboration. Areas covered by the AVM include the image source, descriptive information about the image, details of
the observation, and spatial coordinates. The FITS Liberator also automatically embeds metadata describing the import settings used for an image (this is not a part of the AVM standard, but an extension useful to users wanting to know later how an image was originally generated).

The Metadata tab in the FITS Liberator interface (Figure 7) allows users to enter metadata during the image import process. The user either fills in the metadata fields directly or by choosing from a dropdown list. Some fields retain the values from the last opened image, and others are read directly from keywords in the FITS header.

![Figure 7](image.png) An example of the type of information that is typically entered in the FITS Liberator metadata fields.

To include metadata during the import process, the user should switch to the Metadata tab after the image import settings are chosen. There are several sections:

- **CONTENT**: describes the subject matter of the image.
- **OBSERVATION**: includes specifics of the observation including wavelength and coordinates.
- **PUBLISHER**: information relevant to participants in the VAMP archive.
- **CREATOR**: the facility or person responsible for creating the final image.
- **FITS Liberator**: a record of the import settings used.

All of the fields filled out in the Metadata tab will be written to the image when it is imported into Photoshop after clicking OK.

It is also possible to add/modify/delete metadata for an image within Photoshop itself. This is discussed in more detail in the advanced section below.

For a complete guide to the AVM 1.1 standard consult the documentation at:

http://www.virtualastronomy.org
3.5 Other Utilities

The FITS Liberator distribution includes a number of other useful tools for working with astronomical images in Photoshop.

3.5.1 FITS Concatenator Script

This script will take all of the open images and combine them into a single Photoshop document with each image on a separate layer. This is a convenient way to build a colour composite from multiple images. Use FITS Liberator to read in every desired channel for a colour composite then run this script to consolidate them.

If the FITS files are aligned, the final image will be aligned as well. Otherwise it will be necessary to use Photoshop’s various tools to scale, rotate and move layers to align them to one another.

If the individual images have been tagged with metadata, the script will correctly combine these into the final image.

Note that this script will operate on every open window when it is run. Make sure that anything that does not belong in the final composite is closed before running this script!

The FITS Concatenator should appear in the File>Scripts… menu. If it is not present, make sure the associate files are correctly installed (see section 2).

3.5.2 Colour_composite Action

An example of a Photoshop Action (Colour_composte.atn) is installed with the FITS Liberator and can be used to speed up the process. This Photoshop Action file can be accessed from the Actions palette in the pop-up menu at the upper right. It contains three pre-defined sequences for colouring a layer in Photoshop red, green, or blue.

Once you have a document with multiple greyscale layers (e.g. after copy/pasting in Photoshop or running the FITS Concatenator script if you want to preserve the metadata), these actions automate the process of making a colour composite. Select one of the layers and run one of the colour actions. If you have three layers and run a different colour action on each the result will be a full colour composite of these three images.

Once the layers have been coloured using this Action, the settings may be adjusted directly without having to rerun them. For instance, changing the Hue value in the Hue/Saturation layer will change the colour of the layer.

3.5.3 Metadata Panels

The FITS Liberator also includes six custom panels for Photoshop’s File>File Info… dialog. These panels allow all of the AVM 1.1 metadata tags to be viewed and edited. They will appear as the six “Astro” choices in the panel list on the left.

For a complete discussion of the AVM 1.1 standard and full descriptions of each tag, consult the documentation available at:

http://www.virtualastronomy.org

These metadata panels also enable Adobe Bridge to view embedded metadata in the Metadata pane of the interface. Only a subset of the fields may be edited in the CS3 metadata pane; fields that take multiple values must be changed using the File>File
The Bridge CS4 panels currently do not support browsing the AVM metadata from within the main Bridge window, but the File>File Info... command does allow full editing.

If these panels do not appear in the File>File Info... dialog, check to make sure they were correctly installed (see section 2). Note that starting with Photoshop/Bridge CS4, Adobe has updated the interface for accessing metadata panels. The default installation of the FITS Liberator will install both the CS3 and CS4 compatible panels. The CS4 panels operate similarly, but do have a slightly different appearance.

Figure 8 One of the metadata panels included for the Photoshop CS3 File Info... dialog.

The panels operate like the other Photoshop File Info... panels. Some special features are outlined below:

- Fields that accept multiple values (marked by an asterisk “*”) use the semicolon “;” to separate values.
- Fields that are restricted to specific values are accessed through pop-up menus.
- Dates should be entered using whatever localised format is appropriate for your system (e.g. DD/MM/YYYY for the US).
- Some fields will store recent values that can be quickly entered using the small pop-up menu at the right of the text entry box.

Deleting Metadata
If it is necessary to delete all metadata:
- Click on the Advanced panel at the bottom of the list on the left.
- Select all of the fields that appear on the right.
- Click the Delete button.
Setting up a Template

It can be useful to set up templates for sets of fields that are entered frequently.

- Start with a blank image; it may be helpful to delete all metadata as outlined above.
- Enter the values in every field you want to be part of the template.
- Choose the Save Metadata Template... option from the pop-out menu at the upper right of the window.
- Choose a descriptive name and save.

Saved metadata templates may be applied to images using either Photoshop or Bridge. In Photoshop the template is appended to the existing metadata (overwriting fields that already have an entry). The Metadata palette in Bridge offers the option of appending or replacing (fields not in the template are deleted).
4 Cookbook Examples

Figure 9 Colour-composite annotated image of part of the Galactic Plane seen by the ATLASGAL survey, divided into sections. In this image, the ATLASGAL submillimetre-wavelength data are shown in red, overlaid on a view of the region in infrared light, from the Midcourse Space Experiment (MSX) in green and blue. The total size of the image is approximately 42 degrees by 1.75 degrees.

Credit: ESO/APEX & MSX/IPAC/NASA
4.1 Step-by-step Image Import

Below is a simple step-by-step example showing how to import a FITS file into Photoshop using a specific FITS file from the examples on the FITS Liberator web page. The numbers refer to Figure 11:

1. Go to the example datasets on the FITS Liberator web page: 
2. Download a dataset.
3. Open the images one by one in FITS Liberator.
4. Set the Black and White levels using the sliders (16, 17) to give a good contrast without either too much black or too many oversaturated areas.
5. Click on the background (darkest part of the image) with the Background level selector (9).
6. Click Auto Scaling (57).
7. Try different Stretch functions (51) to enhance the fainter parts of the image.
8. Try different values of Scaled peak level (54) to change the scaling of the image. There is no need to change the Background level (52) and the Peak level (53) as well as these will also just change the amount of scaling (as the Scaled peak level).
9. Click OK.

4.2 Making a Colour Composite Image

The basic principles for making colour composites are:

1. After the “Liberation” above, copy the layers together in Photoshop.
2. Colourise the layers.
3. Use adjustment layers to finalise the image.

A colour composite image is created by assembling two or more greyscale images of the same object taken in different colours, or wavelengths, of light. These may be from the visible part of the spectrum or beyond.

An example of a Photoshop Action (Colour_composite.atn) is installed automatically or supplied on the FITS Liberator download page: [http://www.spacetelescope.org/projects/fits_liberator/download_v23.html](http://www.spacetelescope.org/projects/fits_liberator/download_v23.html) and can be used to speed up the process. It operates on three (aligned) greyscale exposures of the same object in Photoshop.

To install the Action manually:
   - Save the file in the local Actions directory, e.g. /Applications/Adobe Photoshop CS3/Presets/Photoshop Actions).

To load the Action:
   - Go to the Action Window (Window -> Action).
   - Select Load Actions -> Colour_composite.atn (the small arrow in the upper right corner).
   - A series of new commands will appear in the local Actions palette.

To use the Action:
   - Open the three images using the FITS Liberator and copy the three files into three layers of the same file.
   - Select the layer that should appear as blue in the final image and play the "Blue Layer" part of the Action. Answer "Don't Merge", if that question appears.
   - Repeat for the red and green layers.

For more information on creating colour composites consult the tutorial at:
http://www.spacetelescope.org/projects/fits_liberator/stepbystep.html
5 Reference Guide

Figure 10 This infrared picture shows a cloud, known as DR22, bursting with new stars in the Cygnus region of the sky. Spitzer's infrared eyes can both see through and see dust, giving it a unique view into star-forming nests. The blue areas are dusty clouds, and the orange is mainly hot gas.

Credit: NASA/JPL-Caltech/J. Hora (Harvard-Smithsonian CfA)
In this section, we provide more in-depth information about the many different options that FITS Liberator v.2 provides. To give the full overview we will first list all the components in the Graphical User Interface.

Figure 11 FITS Liberator screen shot with all tools and functions marked. These are described below. Note that the Image Statistics can be shown for either the Scaled version of the image (as here) or for the Stretched version of the image. The numbers 41-45 are therefore absent.

Tabs
1. Processing tab
2. Metadata tab
3. FITS header tab
4. Help Guide tab

Tools
5. Move tool
6. Zoom tool
7. Black level selector
8. White level selector
9. Background level selector
10. Peak level selector

Preview Window
11. Preview window
12. Minus button
13. Plus button
14. Zoom pop up

Histogram Window
15. Histogram window
16. Black level slider
17. White level slider
18. Black level text field
19. White level text field
20. Black level button down
21. Black level button up
22. White level button down
23. White level button up
24. Histogram markers

**Network drive warning**

25. Yellow network drive warning

**Image Data**

26. Image/Plane selector
27. X coordinate
28. Y coordinate
29. Right ascension
30. Declination
31. Input value
32. Stretched value
33. Scaled value
34. Width
35. Height

**Image Statistics**

36. Minimum Input
37. Maximum Input
38. Mean Input
39. Median Input
40. Standard Deviation Input
41. Minimum Stretched
42. Maximum Stretched
43. Mean Stretched
44. Median Stretched
45. Standard Deviation Stretched
46. Minimum Scaled
47. Maximum Scaled
48. Mean Scaled
49. Median Scaled
50. Standard Deviation Scaled

**Scaling and Stretch (Advanced)**

51. Stretch function pop up
52. Background level text field
53. Peak level text field
54. Scaled peak level text field
55. Set Background level button
56. Set Peak level button
57. Auto Scaling button

**Channels**

58. Channels 8-bit radio button
59. Channels 16-bit radio button
60. Channels 32-bit radio button

**Undefined Values**

61. Undefined Black radio button
62. Undefined Transparent radio button

**Other Settings**

63. OK button
64. Cancel button
65. Reset button
66. Preferences button
67. Preview checkbox
68. Flip Image
69. Freeze settings checkbox
70. Undefined (red) checkbox
71. White clipping (green) checkbox
72. Black clipping (blue) checkbox
73. Scaled radio button
74. Stretched radio button

The **FITS Liberator** Graphical User Interface (shown above) controls all elements of the import by means of three panels accessed by the tabs along the top row (1-3) and a selection of buttons and options along the right side. The first Processing tab (1) contains all of the controls for adjusting the input FITS image. The second, the
Metadata tab (2) accesses the image and creation tags that are useful for documenting the image and interfacing with services like the Virtual Observatory. The FITS header tab (3) shows the content of the header for the input image. The OK button (58) and the Cancel button (59) accept or abort the input, and the Reset button (60) clears any user settings and returns the image to the default best-guess settings. The esc key can also be used to cancel the plug-in.

Text entered into the text fields is accepted when either the Enter or Tab keys are pressed. The Enter key maintains focus on the current field while Tab advances to the next one. Note that the Enter key is not equivalent to clicking the OK button since it is used for data entry. Copy/paste commands are recognised within the text fields.

### 5.1 Tabs

There are four tabs (1-4) along the top of the Liberator interface:

1. The Processing tab where the image processing is handled.
2. The Metadata tab where Metadata can be entered.
3. The FITS header tab where a text version of the FITS header is listed.

The elements of the Processing tab (1) will be covered in the next sections (5.2 onwards).

The Metadata tab (2) is discussed in more detail in sections 3.4 and Appendix A (below).

The FITS Header tab (3), selected along the top of the FITS Liberator interface, allows the user to view the raw FITS header. This can contain useful, if cryptically encoded, information about the original data. Text from this window can be selected and copied to the clipboard. More information about FITS headers and keywords may be found at:

http://fits.gsfc.nasa.gov/

### 5.2 Processing Tab: Tools

The available tools are found on the left side of the interface on the Processing tab in three groups: the Move and Zoom tools (5,6), Black and White level selectors (7,8), Background and Peak level selectors (9,10).

The top hand-shaped Move tool (5) is for panning in the Histogram and Preview windows. When selected the user can simply click and drag in either window to move items into view. The Move tool may also be temporarily activated by holding down the space bar.

The Zoom tool (6) allows interactive zooming within the Preview (11) and Histogram windows (15). Clicking in either window will zoom in a step around the area clicked. Holding down the alt/option key will zoom out. The user may also drag out a rectangular region to zoom exactly into that portion.

The Black and White levels and Background/Peak level eyedroppers (7-10) are similar in use, but apply to different portions of the interface. They allow their corresponding parameters to be set interactively by clicking within the Preview window. The upper two (7,8) set the Black and White levels (16,17) under the Histogram window; they use
a single-pixel sample. The lower two (9, 10), distinguished by the “B” & “P” labels, set the Background/Peak levels (52,53) in the Scaling and Stretching pane.

Keyboard shortcuts may be used to activate the Tools:
- v for Move tool;
- z for Zoom tool;
- w for White level selector;
- s for Black level selector;
- b for Background level selector;
- p for Peak level selector.

5.3 Processing Tab: Preview Window
The large Preview window (11) in the upper left part of the Processing tab displays a greyscale preview of the imported image that reflects the current Black and White levels and Stretching settings and shows how the image would look if imported. Any update to the display settings will trigger an immediate redraw, which may take some time on slower systems or for larger images. Underneath the window are readouts and controls for setting the Zoom level (12-14). A specific Zoom level may be selected from the pop-up menu (14), or the +/- buttons (12,13) can be used to increment/decrement the zoom value.

5.4 Processing Tab: Histogram Window
The display window on the lower left of the FITS Liberator window (15) shows the current histogram of the image that is displayed in the Preview window. This is similar to the histograms generated within Photoshop, except that the histogram here changes depending on whether the image is the Input Image, the Scaled Image or the Stretched Image. Changes to the Scaling and Stretching settings (see below) will cause the histogram to be regenerated, reflecting any changes to the brightness distribution. The Histogram window may be zoomed in or out using the Zoom tool (6) and moved using the Move Tool (5).

The Black and White levels are set underneath the histogram with the small black/white triangles (16,17). These controls function in much the same way as the Levels dialog box in Photoshop. The black/white sliders may be dragged within the window, or numeric values may be typed into the text fields. Tab or Enter will cause the number to be accepted. The up/down arrows (20-23) by each field adjust the level in increments of 1/10th of a displayed column to allow for finer adjustments than dragging allows. The up/down arrows on the keyboard will work the same way if the text field is highlighted.

5.5 Processing Tab: Image Data
Image/Plane selector (26): The pop-up menu selector (which defaults to “Image 1, Plane 1”) allows the user to select the desired sub-image within a complex data file. While FITS files contain a single image, some datasets allow multiple images to be included in a single file. These can include multiple concatenated images strung together (identified by the Image number), or 3D data cubes (identified by the Plane number).

Multiple images are sometimes combined when they form a series taken of a single source, possibly at different positions or using different filters. Data cubes usually use the third axis to include multiple values of a third parameter, such as steps in wavelength for spectral line imaging.
The *FITS Liberator* can read in one image at a time by selecting the desired image from the pop-up menu. If multiple images need to be read in using identical settings (as is often the case with a data cube), the user may select the Freeze settings checkbox (69) as the first one is read in to retain all Black and White levels and Background/Peak/Stretch settings (see Other Settings below).

The information area underneath the Image/Plane selector (26) is used as the cursor moves over the Preview window. The left column shows the absolute X and Y coordinate (27, 28) of the cursor in the original image relative to the upper left corner. The middle column shows the World Coordinate System (WCS) coordinates Right Ascension (29) and Declination (30) (both in degrees) of the cursor position if WCS info is present in the FITS header of the file. The right-hand column gives the data value at that position for both the Input Image (31) and the Scaled Image (33) (the data after the Background level and a Scaling factor have been applied) respectively or the Stretched Image (32) (after a Stretch function has been applied), depending on the setting of the radio button for Show Image information on the far right side of the interface (73,74).

Further down there is the Width and Height of the image (in pixels (34,35)).

### 5.6 Processing Tab: Image Statistics

The Image Statistics information area (36-50) provides overall statistics for the whole image. As with the Image Data area these values are presented for both the original Input Image and either the Scaled or Stretched Images. The statistics provided include the minimum and maximum data values (36/46, 37/47) as well as the mean (or average) (38/48), median (39, 49), and standard deviation (40, 50).

### 5.7 Processing Tab: Scaling and Stretch (Advanced)

The Scaling and Stretch functions (51-54) in *FITS Liberator* apply a mathematical Stretch to the raw data values to bring out faint details in the image without having to oversaturate the brightest areas of interest. Such Stretches are needed in datasets with a high dynamic range.

The Stretch function pop-up (51) provides a list of mathematical functions that can be applied to the raw data before it is translated to levels of grey for display. These come in four basic groupings:

- Linear — no stretch;
- Logarithmic — ArcSinh(x) and Log(x);
- Roots — \(x^{1/2}\), \(x^{1/3}\), \(x^{1/4}\), \(x^{1/5}\);
- Compound functions — combinations of the above.

Of the Logarithmic functions, the inverse hyperbolic sine, or ArcSinh(x), is preferred for its anti-symmetric behaviour around \(x=0\) (ArcSinh(-x) = -ArcSinh(x)). The scaling of the data has a strong effect on the result of these functions. Log(x) is included for historic reasons, though due to the fact that Log(0) is undefined it is implemented internally as Log(1+x) which behaves very similarly to ArcSinh(x) for \(x \geq 0\).

The Root functions are more commonly known as square root (\(x^{1/2}\)), cube root (\(x^{1/3}\)), etc. The *FITS Liberator* implements each of them to be anti-symmetric around \(x=0\), even though mathematically roots should return undefined (or imaginary) results.
Here they are merely used as tools for dynamic range compression. The Root functions are unaffected by image scaling.

The compound functions provide a variety of subtle differences in how dynamic range is compressed at different levels in the image. Image scaling strongly affects the results of these functions.

Each function provides a slightly different bias to the bright and dark features, and often experimentation is the only way to determine which function is best for a given file. Note that the Histogram window will update with each change in Stretch function to show how it affects the distribution of light and dark pixels. This can be helpful in finding correct background levels and choosing a good Stretch.

All of the Stretch functions in the Liberator work best when the Background level of the data (i.e. the value of the darkest parts of the image) is close to zero. In many astronomical datasets this is not the case due to the way the data were collected or processed. One can examine the data values of the background in an image by passing the cursor over the darkest regions and study the input value readout in the Image Data section. If these values are not clustered around zero, the user should provide an offset to zero them out (explained below).

Some of the Stretch functions provide very different results depending on the Peak level of the data (the largest data values of interest). These functions include ArcSinh(x) or any Log(x) function. If the Peak level is much smaller than 1, the result will be very similar to an unstretched, or Linear, function. If the entire image is scaled upwards (by multiplying by a constant) these Stretch functions will enhance the fainter parts of the image relative to the brightest peaks. This enhancement increases as the Scaled peak level (54) is scaled to larger numbers (100, 1000, etc.).

The FITS Liberator can zero the background properly and adjust the value of the peak. These are set using the values in the Background level (52), Peak level (53), and Scaled peak level (54) text boxes. Before a Stretch function is applied to an image, its data will be rescaled using the formula:

\[
\text{Scaled Image} = \text{Scaled peak level} \times (\text{Input Image} – \text{Background level}) / (\text{Peak level} – \text{Background level})^3
\]

The Background level (52) should be set to equal the numeric value of the pixels in the image that should be rendered as black. These numbers can be determined, for example, by running the cursor over the darkest parts of the image in the Preview window and looking at the Input values under image data (31).

The Peak level (53) should be set to equal the numeric value of the brightest areas of interest in the image. Note that this may not be the absolute brightest object in the image! Often the important part of an image is a nebula or galaxy that is much fainter than the brightest stars. In this case, the Peak level should be set to the very brightest level of the nebula or galaxy.

The Scaled peak level (54) is a free parameter that the user can adjust to obtain the best visual result after the Background level (52) and Peak level (53) have been set appropriately. Note that this will only affect the results of a Log() or ArcSinh() Stretch function. Useful values tend to be in the range of 10 to 10,000, with the larger values

\[\text{Note that this equation is slightly simplified as the parameter Scaled Background level mentioned in Appendix B has been set explicitly to zero in FITS Liberator v.2.}\]
bringing up more of the faint detail. Values as small as 0.1 are nearly indistinguishable
from a simple Linear function and will not enhance faint structure at all.

The *FITS Liberator* allows the Background level (52) and Peak level (53) to be set in four
different ways:

1. **Auto Scaling button** (57): Clicking this button will use the existing settings for
   the Black and White level indicators below the Histogram window and set the
   Scaled peak level to 10. This is often a good first guess.
2. **Background level and Peak level from reading the Black and White level buttons under the Histogram window** (18, 19): The buttons to the right (55, 56) allow the user to individually set the Background/Peak levels based on the respective Black and White level settings. Unlike the Auto Scaling button, only one of the values is updated at a time, and the Scaled peak level (54) keeps its current value. Note that the histogram range (15) will be adjusted when the Scaling takes place (as the Background level and the Peak level change), i.e. the histogram now shows the pixel value distribution of the Scaled Image and not the original Input Image.
3. **Background/Peak level selectors** (9, 10): The bottom two eyedropper tools in
   the toolbox will directly sample Background/Peak levels from within the image.
   They take the median value of a 10x10 box around the click location.
4. **Text field entry** (52, 53): Values can be typed directly into the text fields.
   Hitting either the Tab or Enter keys is necessary for the change to take effect.
   Scientific notation of the form “1.25e5” may be used if desired.

**NOTE:** The Background level must logically be smaller than the Peak level. Any attempt
to violate this using any input method will be ignored. Note also that the initial values
for Peak level and Scaled peak level are set to the best guess for the White level; this
means that the default result for the Scaled data will be equal to the Input value (i.e. no
Scaling).

To experiment with these adjustments, open an image with high dynamic range (for
example a galaxy or nebula image). Use one of these methods to set the Background
level to the value of the background noise in the image and the Peak level to the
brightest area of interest. Now choose either the Log(x) or ArcSinh(x) Stretch function.

To see how Scaled peak level (54) affects the Stretch, experiment by entering different
numbers in this field. Start with values around 0.1 and switch back to Linear for
comparison; they should look very similar. Switch back to the other function and start
increasing the Scaled peak level by factors of 10: 1, 10, 100, 1000. Notice how the larger
values enhance the fainter structures better. Figure 6 illustrates the effects of the
different Stretch functions and Peak level on a single image.

### 5.8 Processing Tab: Channels

The Channel radio buttons (58-60) determine the bit depth read into Photoshop.
Photoshop 7 and CS can both handle 8-bit or 16-bit channels, while CS2 and CS3 can
handle 32-bit channels.

The default for this is 16-bit channels, which gives a lot of flexibility in subsequent
adjustments in Photoshop without risk of posterizing (this is most likely when using
large gamma or Curves adjustments to bring up faint features). It is possible to use 8-
bit as well, but this is suggested only for extremely large images, since it will reduce the
file size by a factor of two.
Photoshop does support 32-bit channels, but treats such images differently. This mode is intended for HDRI (High Dynamic Range Imaging) that captures the full luminance in a photographic scene. While this is similar to the challenges faced in rendering high dynamic range astronomical images, few of the standard tools are supported, making it difficult to create good image composites in this mode.

5.9 Processing Tab: Undefined Values

Undefined data values arise in an image if there is no data for that region. Some FITS files mark empty pixels as “blank” using a special data value. The FITS Liberator uses the Undefined Values Radio buttons (61, 62) determine how these pixels are rendered into Photoshop. If Black (61) is selected, then they simply appear as black pixels. If Undefined Transparent (62) is selected, the image is read in as a Photoshop layer with transparent areas wherever the image is undefined.

5.10 Processing Tab: Other Settings

The far right column (63-74) of the FITS Liberator provides a number of useful settings. In addition to the OK button (63) and the Cancel button (64), the user can use the Reset button (65) to return to the best initial guesses for the parameters and the Preferences button (66) to open a new dialog with various options for setting the initial guess and histogram markers. The Preview checkbox (67) enables the Preview window (11) on the left (it may be useful to turn this off to improve performance on large files).

The Flip Image checkbox (68) determines how a FITS image will be rendered. The FITS format is very flexible in how image data can be recorded as data; it may be entered row-by-row from either the bottom or top. Standard image viewing formats always display from the top down. Therefore it is often necessary to vertically flip an image so it displays properly in Photoshop (this usually means how it is seen on the sky). The FITS Liberator will attempt to determine the proper setting for this checkbox from the header, but if the image appears mirror-imaged, the user can flip it the other way manually by checking or unchecking this setting.

The Freeze settings checkbox (69) will force the Liberator to use all of the current image settings (Black and White levels, Background level, Peak level, Scaled peak level, and Stretch function) the next time any FITS file is opened. The new file may be different or the same one. This is useful when a series of images need to be opened with identical settings so they can be directly compared. Note that the Liberator also retains these settings for the individual images when they are opened again, even if Freeze settings is switched off.

The Mark Pixels checkboxes in Preview settings (70-72) allow the user to see where data may be lost in the Preview window. The checkboxes allow three options to be toggled on and off. Red (70) is used to mark Undefined pixels, whether from missing data or from the application of certain Stretch functions. Green (71) indicates areas where highlights are clipped because they exceed the White level setting. Blue (72) shows where the pixel values fall below the Black level setting. These pixel previews can be helpful in seeing whether the Black and White levels are set too close together.

The radio buttons under Show Image information (73, 74) allow the user to switch between readouts of Scaled or Stretched data. This setting affects the Image Data and Image Statistics readouts.
5.11 Preferences Dialog

The new options dialog as displayed in Figure 12 include the possibility of changing the initial guess for the black and white levels (numbers 1-3 in the figure). The user can choose which method (1):

- Percentage
- Mean +/- stdev or
- Median +/- stdev.

When choosing Percentage in (1), the user is asked to input the thresholds for the black (2) and white (3) levels in percent of the total amount of pixels. In the two latter cases the white and black levels are set to the mean +/- the standard deviation or the median +/- the standard deviation, respectively. The text fields, for these options, are multiplicative factors for the standard deviation to set the black and white levels independently.

The default stretch function can also be chosen (4). FITS Liberator will use this choice when opening an image that has not been opened before and the freeze settings option is switched off. Likewise, the default Scaled peak level can be set (5).

The histogram markers (6) can be turned on or off independently as the user wishes. These are marked with different colours and the change appears immediately in the histogram in the main dialog.

Item number 7 in Figure 12 indicates a button labelled Clear history. Pressing this button will clear the history of the current image.

Finally, numbers 8-10 mark the Ok (8), Cancel (9) and Defaults (10) buttons. The latter button resets the options to the default settings.
Note that when you enter values into the various text fields, you should use the TAB key to register the changes. Just entering the text and immediately clicking OK will not save the updated value.
A. More about Metadata

The Virtual Astronomy Multimedia Project (VAMP) will enable access to, and vastly increase the use of, astronomy image resources. VAMP will enable innovative future exploitation of all kinds of outreach media by systematically linking resource archives worldwide.

To this end, VAMP has developed an international standards system for Astronomy Visualization Metadata (AVM) that is currently at version 1.1. Such a standard will allow a much more coordinated and widespread utilisation of the products. The inclusion of metadata tags for astronomical colour images are included in the FITS Liberator v.2 as the forerunner of a more general use in all future outreach products.

The FITS Liberator is a primary tool for embedding AVM tags within images, either at the FITS import stage or later using the File Info... dialog panels. Images tagged with this metadata have the potential to be used in a wide variety of innovative applications now under development.

A brief summary of each of the tags, their format, and an example of a typical value is given in the following table. For extensive documentation on VAMP and the AVM 1.1 tags, visit the website:

http://www.virtualastronomy.org
### AVM Tag Name
<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Creator Metadata</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creator</td>
<td>string</td>
<td>Spitzer Science Center</td>
</tr>
<tr>
<td>CreatorURL</td>
<td>URL</td>
<td><a href="http://www.spitzer.caltech.edu">http://www.spitzer.caltech.edu</a></td>
</tr>
<tr>
<td>Contact.Name</td>
<td>string, list</td>
<td>R. Hurt</td>
</tr>
<tr>
<td>Contact.Email</td>
<td>string, list</td>
<td><a href="mailto:example@ipac.caltech.edu">example@ipac.caltech.edu</a></td>
</tr>
<tr>
<td>Contact.Telephone</td>
<td>string, list</td>
<td>555-555-5555</td>
</tr>
<tr>
<td>Contact.Address</td>
<td>string</td>
<td>1200 E. California Blvd.</td>
</tr>
<tr>
<td>Contact.City</td>
<td>string</td>
<td>Pasadena</td>
</tr>
<tr>
<td>Contact.StateProvince</td>
<td>string</td>
<td>California</td>
</tr>
<tr>
<td>Contact.PostalCode</td>
<td>string</td>
<td>91125</td>
</tr>
<tr>
<td>Contact.Country</td>
<td>string</td>
<td>USA</td>
</tr>
<tr>
<td>Rights</td>
<td>string</td>
<td>Public Domain</td>
</tr>
<tr>
<td><strong>Content Metadata</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>string</td>
<td>NGC 1566</td>
</tr>
<tr>
<td>Headline</td>
<td>string</td>
<td>The spiral galaxy NGC 1566, located in the constellation of Dorado, is rendered in infrared light.</td>
</tr>
<tr>
<td>Description</td>
<td>string</td>
<td>This beautiful spiral galaxy NGC 1566, located approximately 60 million light-years away in the constellation of Dorado was captured by the Spitzer Infrared Nearby Galaxies Survey (SINGS) Legacy Project using the telescope's Infrared Array Camera. C.5.1.1;C.5.3.2.2</td>
</tr>
<tr>
<td>Subject.Category</td>
<td>string-CV, list</td>
<td>NGC 1566</td>
</tr>
<tr>
<td>Subject.Name</td>
<td>string, list</td>
<td>1250;</td>
</tr>
<tr>
<td>Distance</td>
<td>string, list(2)</td>
<td>Approximate value provided by PI</td>
</tr>
<tr>
<td>Distance.Notes</td>
<td>string</td>
<td><a href="http://gallery.spitzer.caltech.edu/Imagegallery/image.php?image_name=sig05-013">http://gallery.spitzer.caltech.edu/Imagegallery/image.php?image_name=sig05-013</a></td>
</tr>
<tr>
<td>ReferenceURL</td>
<td>URL</td>
<td>NASA/JPL-Caltech</td>
</tr>
<tr>
<td>Date</td>
<td>date</td>
<td>2007-08-12</td>
</tr>
<tr>
<td>ID</td>
<td>string</td>
<td>sig05-013</td>
</tr>
<tr>
<td>Type</td>
<td>string-CV</td>
<td>Observation</td>
</tr>
<tr>
<td>Image.ProductQuality</td>
<td>string-CV</td>
<td>Good</td>
</tr>
<tr>
<td><strong>Observation Metadata</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Facility</td>
<td>string, list(s)</td>
<td>Spitzer;Spitzer;Spitzer</td>
</tr>
<tr>
<td>Instrument</td>
<td>string, list(s)</td>
<td>IRAC;IRAC;IRAC;IRAC</td>
</tr>
<tr>
<td>Spectral.ColorAssignment</td>
<td>string-CV, list(s)</td>
<td>Blue;Green;Red;Red</td>
</tr>
<tr>
<td>Spectral.Band</td>
<td>string-CV, list(s)</td>
<td>Infrared;Infrared;Infrared;Infrared</td>
</tr>
<tr>
<td>Spectral.Bandpass</td>
<td>string, list(s)</td>
<td>Near-Infrared;Near-Infrared;Near-Infrared;Near-Infrared</td>
</tr>
<tr>
<td>Spectral.CentralWavelength</td>
<td>float, list(s)</td>
<td>3600;4500;5800;8000</td>
</tr>
<tr>
<td>Spectral.Notes</td>
<td>string</td>
<td>Blue indicates emission at 3.6 microns, green corresponds to 4.5 microns, and red to 5.8 and 8.0 microns.</td>
</tr>
<tr>
<td>Temporal.StartTime</td>
<td>date, list(s)</td>
<td>2002-12-21-0900; 2002-12-21-0900; 2002-12-21-0900; 2002-12-21-0900</td>
</tr>
<tr>
<td>Temporal.IntegrationTime</td>
<td>float, list(s)</td>
<td>10;10;10;10</td>
</tr>
<tr>
<td>DatasetID</td>
<td>string, list(s)</td>
<td>a1;a2;a3;a4</td>
</tr>
</tbody>
</table>
### Coordinate Metadata

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spatial.CoordinateFrame</td>
<td>string-CV</td>
<td>ICRS</td>
</tr>
<tr>
<td>Spatial.Equinox</td>
<td>string</td>
<td>2000</td>
</tr>
<tr>
<td>Spatial.ReferenceValue</td>
<td>float, list(2)</td>
<td>65.0696476555;54.9319798442</td>
</tr>
<tr>
<td>Spatial.ReferenceDimension</td>
<td>float, list(2)</td>
<td>974;974</td>
</tr>
<tr>
<td>Spatial.ReferencePixel</td>
<td>float, list(2)</td>
<td>616.293197632;346.155345917</td>
</tr>
<tr>
<td>Spatial.Scale</td>
<td>float, list(2)</td>
<td>-0.000208670950176;0.000208670950176</td>
</tr>
<tr>
<td>Spatial.Rotation</td>
<td>float</td>
<td>-124.2050324</td>
</tr>
<tr>
<td>Spatial.CoordsystemProjection</td>
<td>string-CV</td>
<td>TAN</td>
</tr>
<tr>
<td>Spatial QUALITY</td>
<td>string</td>
<td>Full</td>
</tr>
<tr>
<td>Spatial.Notes</td>
<td>string</td>
<td>FOV: 12.19 x 12.19 arcminutes; Ref coordinate: 4h20m16.72s -54d55m55.13s; derived from astrometry.net file sig05-013.fits</td>
</tr>
<tr>
<td>Spatial.FITSHeader</td>
<td>string</td>
<td>CRVAL1 = 6.3856 CRVAL2 = 64.1784 RADESYS = 'ICRS ' EQUINOX = 2000. CYTYP1 = 'RA---TAN-SIP' CYTYP2 = 'DEC--TAN-SIP' CRPIX1 = 214. CRPIX2 = 138. 2</td>
</tr>
<tr>
<td>Spatial.CDMMatrix</td>
<td>float, list(4)</td>
<td></td>
</tr>
</tbody>
</table>

### Publisher Metadata

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>string</td>
<td>Spitzer Space Telescope</td>
</tr>
<tr>
<td>PublisherID</td>
<td>string</td>
<td>vamp://spitzer</td>
</tr>
<tr>
<td>ResourceID</td>
<td>string</td>
<td>sig05-013_jpg_sm</td>
</tr>
<tr>
<td>RelatedResources</td>
<td>list</td>
<td>vamp://spitzer/sig05-011; vamp://spitzer/sig05-012</td>
</tr>
<tr>
<td>MetadataDate</td>
<td>date</td>
<td>2007-11-17</td>
</tr>
<tr>
<td>MetadataVersion</td>
<td>string</td>
<td>1.1</td>
</tr>
</tbody>
</table>

### File Metadata

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileType</td>
<td>string-CV</td>
<td>JPEG</td>
</tr>
<tr>
<td>FileDimension</td>
<td>float, list(2)</td>
<td>974;974</td>
</tr>
<tr>
<td>FileSize</td>
<td>float, list(2)</td>
<td>180</td>
</tr>
<tr>
<td>FileBitDepth</td>
<td>float</td>
<td>16</td>
</tr>
</tbody>
</table>
B. Behind the scenes

In the usual sequence of processing an image, the image typically moves through four distinct stages:

1. **Input Image**: The reduced, cleaned image from the astronomical processing.
2. **Scaled Image**: The Input Image scaled up or down so as to let the pixel values fall in the range where the Stretch function works best. If the Input Image contains, for instance, pixel values in the range [5:50,000], the Scaled Image might be chosen to contain pixel values from [0:10] (for instance by applying Auto Scaling) to fit with a Logarithmic Stretch function better.
3. **Stretched Image**: The Scaled Image transformed by a Stretch function, for instance a Logarithmic Stretch.
4. **Output Image**: The image that arrives in Photoshop for further processing. This is qualitatively the same as the Stretched Image, but is scaled to the desired bit depth in Photoshop (e.g. 16-bit: [0, 65535])

Comparative Histograms for an example with the four Image types are shown in Figure 11 below, illustrating the evolution of the image through the processing sequence. Note that the FITS Liberator defines Logarithm as \( \text{Log} = \log_{10}(\text{Scaled Image} + 1) \) for consistent behaviour around the background or zero level.

---

2 Defined as \( \text{Scaled Image} = \text{ScaledBackgroundLevel} + (\text{ScaledPeakLevel} – \text{ScaledBackgroundLevel}) \cdot (\text{Input Image} – \text{BackgroundLevel}) / (\text{PeakLevel} – \text{BackgroundLevel}) \)
Figure 13: Example histograms for the four different images created during a typical workflow process: a) Input Image, b) Scaled Image, c) Stretched Image (here with a Logarithmic Stretch function) and d) Output Image (in Photoshop).
Index

16 bit, 31, 38
32 bit, 5, 8, 31
8 bit, 8, 13, 31
Auto Scaling, 16, 22, 26, 31
average, 29, See mean
Background level, 15, 26, 29, 30, 31, 32
Background level selector, 25, 28
Background level text field, 26
Black and White levels, 22, 27, 28, 29, 31, 32
Black clipping (blue) checkbox, 26
Black level button down, 25
Black level button up, 25
Black level selector, 25, 28
Black level slider, 25
Black level text field, 25
burn in, 13
Cancel button, 26, 27, 32
Channels, 31
Channels 16-bit, 26
Channels 32-bit, 26
Channels 8-bit, 26
clipping, 32
Curves in Photoshop, 14
data cube, 28, 29
dynamic range, 13, 29, 31
Enter key, 27, 28, 31
European Southern Observatory, 5
European Space Agency, 5
FITS, 2, 5
FITS header, 5, 27
FITS header tab, 25, 27
FITS Liberator web page, 22
Flexible Image Transport System. See FITS
Freeze settings, 26, 29, 32
Graphical User Interface, 25, 26
Height, 26, 29
Histogram window, 25, 27, 28, 31, 38
Hubble Space Telescope, 5
image axes, 28
Image Data, 29, 30, 32
Image Statistics, 25, 29, 32
Image/Plane selector, 26, 28, 29
Input Image, 26, 27, 28, 29, 38, 39
Input value, 26, 30, 31
Levels in Photoshop, 14
Linear, 13, 30, 31
Log, 16, 30, 31, 38, See Logarithm
Logarithm, 14, 38, 39
Mark pixels, 32
mathematical functions, 15, 29
maximum data values, 29
Maximum Input, 26
Maximum Scaled, 26
Maximum Stretched, 26
mean, 29
Mean Input, 26
Mean Scaled, 26
Mean Stretched, 26
median, 29, 31
Median Input, 26
Median Scaled, 26
Median Stretched, 26
Minus button, 25
Move tool, 25, 27, 28
multiple images, 28
NASA, 5
OK button, 26, 27, 32
Output Image, 38, 39
over-saturate, 13, 29
Peak level, 15, 26, 30, 31, 32
Peak level selector, 25, 27, 28, 31
Peak level text field, 26
Pillars of Creation, 5, 6
Plus button, 25
posterize, 14, 31
Preview checkbox, 26, 32
Preview window, 25, 27, 28, 29, 30, 32
Processing tab, 25, 26, 27
Reset button, 26, 27, 32
Scaled Image, 26, 28, 29, 31, 38, 39
Scaled peak level, 15, 16, 26, 30, 31, 32
Scaled peak level text field, 26
Scaled value, 26
Scaling, 5, 14, 16, 28, 29, 31
Set Background level, 26
Set Peak level, 26
Show Image information, 29, 32
Show Scaled value, 26
Show Stretched value, 26
Spitzer Space Telescope, 5
standard deviation, 29
Standard Deviation Input, 26
Standard Deviation Scaled, 26
Standard Deviation Stretched, 26
Stretch function, 16, 22, 26, 29, 30, 31, 32, 38, 39
<table>
<thead>
<tr>
<th>Term</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stretched Image</td>
<td>26, 28, 29, 38, 39</td>
</tr>
<tr>
<td>Stretched value</td>
<td>26</td>
</tr>
<tr>
<td>Stretching</td>
<td>5, 14, 28, 29</td>
</tr>
<tr>
<td>Tab key</td>
<td>27, 28, 31</td>
</tr>
<tr>
<td>Technical requirements</td>
<td>8</td>
</tr>
<tr>
<td>Tools</td>
<td>25, 27, 28</td>
</tr>
<tr>
<td>transparent</td>
<td>32</td>
</tr>
<tr>
<td>Undefined</td>
<td>26, 32</td>
</tr>
<tr>
<td>Undefined (red) checkbox</td>
<td>26</td>
</tr>
<tr>
<td>Undefined Black</td>
<td>26</td>
</tr>
<tr>
<td>Undefined Transparent</td>
<td>26, 32</td>
</tr>
<tr>
<td>Very Large Telescope</td>
<td>5</td>
</tr>
<tr>
<td>Virtual Observatory</td>
<td>27</td>
</tr>
<tr>
<td>White clipping (green) checkbox</td>
<td>26</td>
</tr>
<tr>
<td>White level</td>
<td>See Black and White levels</td>
</tr>
<tr>
<td><strong>White level button down</strong></td>
<td>26</td>
</tr>
<tr>
<td>White level button up</td>
<td>25</td>
</tr>
<tr>
<td>White level selector</td>
<td>25, 28</td>
</tr>
<tr>
<td>White level slider</td>
<td>25</td>
</tr>
<tr>
<td>White level text field</td>
<td>25</td>
</tr>
<tr>
<td>Width</td>
<td>26, 29</td>
</tr>
<tr>
<td>X coordinate</td>
<td>26, 29</td>
</tr>
<tr>
<td>XMM-Newton</td>
<td>5</td>
</tr>
<tr>
<td>Y coordinate</td>
<td>26, 29</td>
</tr>
<tr>
<td>Zoom pop up</td>
<td>25</td>
</tr>
<tr>
<td>Zoom tool</td>
<td>25, 27, 28</td>
</tr>
</tbody>
</table>